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Sirius L Tube Luminometer 1. Preface

1. Preface

1.1 Contact information

Berthold Detection Systems GmbH
Bleichstral3e 56-68
D-75173 Pforzheim

Sales and Customer Service

Internet:  www.titertek-berthold.com
Phone: +49 (0) 7231-9206-0

Fax: +49 (0) 7231-9206-50
E-Mail: sales@titertek-berthold.com

Instruments Technical Support
Phone: +49 (0) 7231-9206-25

Fax: +49 (0) 7231-9206-50
E-Mail: service@titertek-berthold.com
1.2 Typographical Conventions

This manual uses the following typographical conventions:

Icon Description

This caution sign calls attention to important
safety information to be read in the manual.

The caution sign indicates the potential for risk
of electric shock.

> This symbol advises the reader to consult the
| | operating instructions for information needed

for the proper use of the device.
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1. Preface Sirius L Tube Luminometer

These icons may appear on the instrument:

Icon Description

Manufacturer

This product bears the CE mark.

for the proper use of the device.

Dispose the instrument according to Directive
2002/96/EC, on waste electrical and electronic
equipment (WEEE)".

This caution sign calls attention to important
safety information to be read in the manual.

> This symbol advises the reader to consult the
1 operating instructions for information needed
I

1.3 Revision History
Date Changes
2010-03 Initial document

New manual template. Revision of Logo, contact
information and typographical conventions.
2011-11 Transport conditions and disposal of biohazard
waste added.
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Sirius L Tube Luminometer 1. Preface

1.4 Intended Use Statement

Description of Sirius L

The Sirius L tube luminometer is a highly sensitive and compact
single sample luminometer, designed specifically for the detection
of chemiluminescence and bioluminescence in different kinds of
applications. Due to its small footprint it can be set up in any lab
workplace. In its basic version it can be employed for all glow type
measurements. Equipped with injectors, the instrument may also
be used for flash luminescence measurements. The sample
chamber accommodates various sample formats. Sirius L is
operated using special Windows software.

Intended Use:

The Sirius L Tube Luminometer combined with FB12/ Sirius
software may be used for the following purposes:

Academic research, e.g. biology, chemistry, human and
veterinary medicine.

Hygiene control, e.g. water measurement.

Pharmaceutical industry, e.g. drug discovery research,
quality control in production.

Sirius L may only be used for measurement of bio-and
chemiluminescence in single samples. No others than the
purposes described in the Intended Use may be operated on the
system.

Constraints:

Sirius L with FB12/ Sirius software must not be used for
In vitro diagnostics.

1.5 Certifications
This instrument bears the CE mark, based on conformity to
current EC legislation.
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1.6 Safety Instructions and Precautions

Please adhere to the following safety instructions and
precautions before and during operation of the system or
taking the instrument into service:

1.

62303).docx

The instruments have been tested by the manufacturer and
are supplied in a condition that allows safe and reliable
operation. The manufacturer guarantees safe operation of the
equipment, both electrically and mechanically, if user follows
the instructions set forth in this manual.

The person, responsible for bringing the instrument to market,
has to assure, that the safety instructions and precautions of
this manual are communicated to the user.

Only qualified trained personnel may operate the instrument.

It is strongly recommended that all users read this manual
prior to use. This User's Manual includes information and
warnings that have to be observed by the user to ensure safe
operation of the instruments.

It is the operator's responsibility to adhere to regulations on
the installation and/or operation of sample measuring systems
that are required by local legislation of the country of its
installation.

The user must ensure that the instruments are set up and
installed in such a way that their function is not impaired.
Please refer to the luminometer installation description.

Only accessories coming with the instrument or delivered by
Berthold Detection Systems for work with this instrument may
be used for operation.

Do not connect the power cord near fluids to avoid electric
shock and burning. The power cord must never become wet!

The power supply must be connected to a wall outlet
complying with local regulations of the country of its
installation and providing voltage and current according to the
specification of the system.
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10.

11.

12.

13.

14.

15.

16.

17.

18.

19.

20.

Berthold Detection Systems assumes no liability for any
damages, including those to third parties, caused by improper
installation, use or handling of the device. The instruments are
live and improper handling may cause damage.

The instrument may only be used for the designated
application. Please refer to the Intended Use Statement and
the Constraints.

The user must assure that assays are validated with the
system prior to routine use.

Some assays, assay components or specimen may pose a
biohazard or risk for infection. Always refer to the assay's
package insert for adequate safety precautions. Wear
appropriate protective equipment like laboratory coats or
chemically resistant rubber cloves and act carefully to avoid
contamination.

The instrument must be decontaminated before repair work or
service to avoid contact of the service personnel with potential
biohazard material.

Only service engineers authorized by Berthold Detection
Systems may carry out service and repair work. Before
continued use reassemble and check the instrument
according to instructions in the service manual.

For servicing use only parts qualified by Berthold Detection
Systems.

Always disconnect the power cord before opening the
instrument for service or modifications.

The user may only perform the maintenance work described
in this manual. The user must not open the instruments
chassis.

The tests and maintenance work recommended by the
manufacturer should be performed to make sure that the
operator remains safe and that the instrument continues to
function correctly.

If you realize that the instrument has become unsafe to use,
switch it off and disconnect it from the power supply.

TITERTEK
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1. Preface Sirius L Tube Luminometer

21. Avoid spilling liquids on the outer surface and the sample
chamber of the instrument. Wipe up all spills immediately and
decontaminate the surfaces in cases of biohazard spilling
liquids.

22. If liquid gets inside the instrument, pull the power cord
immediately. Do not operate the instrument if internal
components have been exposed to fluids, since they create a
potential for electric shock and burning. Have the instrument
cleaned by an authorized service center.

Risk Management Statement

Sirius L with and without injectors is subject to a continuous risk
analysis and evaluation according to EN 14971. The information
in this manual complies with the actual state of knowledge at the
publication date. When Sirius L is operated in compliance with the
instructions in this manual there are no known risks for the user,
the environment or the quality of the measurement results.
However, the user should be aware of situations that could result
in serious damage. Always read the safety instructions and
precautions carefully!

Storage conditions

Before delivery or if the instrument is not used for a longer period
of time, store it in the original cardboard box in a dry dust-free
environment and protected from direct sunlight and significant
temperature fluctuations!

Storage temperature:
0-40°C up to 80% humidity (@30°C), non condensing

Transport conditions
-25° to +60°C, up to 75% humidity, in original cardboard box and
free of liquids.
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Quality control

It is considered good laboratory practice to run laboratory
samples according to instructions and specific recommendations
included in the package insert of the reagent kit or the standard
laboratory protocol for the test to be conducted. A failure in the
performance of Quality Control checks could result in erroneous
test data.

Samples should be obtained, treated and stored following the
instructions and recommendations of the kit insert.

It is recommended to run known internal quality standards or
samples attendant to the measurement runs or to use the LED
TestTube, offered by Berthold Detections Systems, for instrument
validation measurements.

Return shipment

If the instrument has to be returned to Berthold Detection
Systems for servicing or inspection, we recommend that you use
the original cardboard box. Refer to the chapter 14 for details.
Always decontaminate the instrument according to the description
in the decontamination form in chapter 15. Fill out this
decontamination form before return shipment. Berthold Detection
System will not accept instruments without filled out
decontamination form for repair or inspection.

Disposal

Decontaminate the instrument before disposal! This luminometer
contains electronic parts. To prevent environmental pollution
please dispose the instrument and the corresponding accessories
according to local legislation. Within the EC dispose the
instrument and accessories according to the directive 2002/96/EC
or contact our local representative.

This product uses the FreeRTOS.org real time kernel — The
freeRTOS.org source code can be obtained by visiting
http://www.FreeRTOS.org

User’s Manual Sirius L-e-2011-11 (ID
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Disposal of potential biohazard and chemical waste

To prevent chemical burn, contamination, potential infection and
environmental pollution, please dispose chemical or potential
biohazard waste always carefully and according to local
legislation. It is recommended to treat potential biohazard waste
by autoclave.
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2. Getting Started
Carefully unpack the SIRIUS L Luminometer and put it on your
desktop.

Figure 2-1:

Sirius L with 2

injectors

2.1 Luminometer Installation

O The instrument should be set up in a dry, dust-free
environment and protected from direct sunlight and significant
temperature fluctuations!

O Check the package content to be complete for your model.

O A standard sample holder for 75x12mm and 55x12mm tubes
is preinstalled in the factory. Open the measurement chamber
and check the sample holder to be still ready installed. Check
the 2 screws at the bottom of the sample holder to be tighten.

O Sample holder for other sample formats have to be ordered
additionally and are not part of the standard scope of delivery.
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2. Getting Started Sirius L Tube Luminometer

Figure 2-2:
Sirius L sample
holder

Sample holder for

Sample holder for microfuge tubes
75x12mmand @
55x12mm tubes

. -

U The following sample formats may be used in Sirius L models
with and without injectors:

With a standard sample holder:
75x12mm tubes
55x12mm tubes (together with the Plexiglas insert)

With a microfuge tube sample holder:
Microfuge tubes 1.5ml and 2ml

O The following sample formats, not allowed for use with
3 J injectors, may also be used with a special sample holder.
-5 v Culture dishes with up to 35mm diameter
-f®' B - | Scintillation bottles containing up to 20ml

Other reaction bottles with up to 12mm diameter

U Do not use the instrument with others than the specified tube
formats for your sample holder.

O For injector models: Check the injector head and the screws
of the injector tubing on top of the instrument to be still
tightened to avoid undesirable light incidence. Be careful and
make sure that the fittings screws are only finger tightened.
Do not use any tools!

Figure 2-3:
Injector head and Injector tubing
tubing connections

Fitting screw
with protective

__—— rubber

Banjo nut

Injector head
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Sirius L Tube Luminometer 2. Getting Started

U0 Check the tubing connections at the injector pumps to be
finger-tightened to avoid leakage.

QO Pumps are labeled with numbers to simplify the identification.
This number is also used by the PC software to identify the
injectors and to avoid confusion.

Figure 2-4:
Injgctor pumps and Black tubing
tubing connections / from pump to
injector head
/V
White Number
tubing of injector
from bottle
to pump
U Connecting cables at the rear panel:
Figure 2-5:

Sirius L rear view

| __—1 ON/OFF switch

| —— USB port

RS232 port

£ Socket

Connect the instrument to mains with the desktop power
supply and the country specific power cord delivered with the
instrument. Refer to the power requirements in the Technical
Data and to the safety information.
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U Connect the instrument to PC via USB or serial port.
O Operating conditions:
Operation Temperature: 10-35°C up to 70% humidity

It is strongly recommended to operate luminescence
measurements at room temperature (20°C) to achieve the
performance characteristics listed in the technical data.

Operation upon the specified temperature range may
cause in a sharp increase of the instrument background to
values clearly outside the specified range.

U Turn the instrument on at the mains switch.

Power LED Q Every time Sirius L is switched on, it acts in a basic mode,

called FB12 mode, first. The power LED at the side of the
| instrument will periodically light up and down. If the instrument
{/ is controlled by FB12/ Sirius software V2.0 or higher, it is
n switched into an advanced mode. The power LED will light up
e constantly, then. Refer to chapter 4 for details.
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3.1

3.1.2

TITERTEK
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Measurement
Overview

The luminometer should be switched on at least 30 minutes
before starting a measurement.

Light Detection

A photomultiplier tube (PMT) is used for light detection. It
measures visible light in the spectral range between300 and 630
nm. The PMT converts the photons emitted by the sample into
electrical pulses. Every single pulse is then digitally counted
(photon counting method). The number of pulses is directly
proportional to the light intensity. The light emitted by the sample
is collected from the bottom of the tube. To collect as much light
as possible, the sample holder is additionally polished to optimize
reflection. Sirius L measures a dynamic range of 6 decades.

Units

There is no standardized unit for chemi- or bioluminescence.
Therefore, results should only be compared with each other when
they are measured on the same instrument. Berthold Detection
Systems standardizes the Relative Light Units to the number of
single photon pulses counted during the period of 1 second
(RLU/s), multiplied by the RLU-factor which defaults to a setting to
1.

RLU/s = cps ...RLU factor
The factory-set factor (=1) cannot be changed by the user.

The RLU/s value obtained by the luminometer is the relative light
intensity. This does not directly represent the analytical result of
an analysis. It is subject to further data evaluation. It is in the
liability of the user to evaluate clinical results out of these RLU/s
values by use of adequate calculation methods, selected in
accordance to the needs of the assay performed. The whole
system of luminometer, assay and evaluation software on a PC,
must be validated by the user.
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3.14

Fig. 3-1:

Definition of
measurement and
delay times

Overload

If one or several measured values in the measurement interval
exceed the measuring range of the luminometer, OVERLOAD is
detected by the instrument. In this case, the shutter will be
automatically closed and the software sends the overload signal
which is represented by an RLU/s value of 30e6 RLU/s.

Shutter Operation

The Sirius L is equipped with a shutter to protect the
photomultiplier tube against light. If the instrument is switched on
and the door is closed, the shutter will automatically open. If the
user opens the door, the shutter will automatically close and will
not open again until the door is closed again. The shutter
operation may be identified by the shutter noise. In cases of
overload the shutter will always close automatically.

A shutter operation fail is detected by the software. In cases of a
not totally opened shutter, the software sends the overload signal
to the communication interface.

Delay injector 1
Delay injector 2

Delay measurement Measurement time

9|
1

»
»

Door t=0

a: Shutter opening after door close
b: Initialization of injectors

Shutter and injectors are prepared to be ready for use between
“door close” and t=0. All delay times start with t=0.

62303).docx
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3.1.5

3.2

3.3

TITERTEK
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Sample Tubes

Sample tubes are made of polystyrole (PS) or polyethylene (PE).
These materials are sensitive to light and electrostatic influences.
Store sample tubes therefore in the dark and protect them from
bright light. PS tubes are less sensitive to light than PE tubes.
Please avoid also immoderate tube handling to prohibit
electrostatic influences, which may deflect the reagents during
injection and result in splashes at the inner walls of the tubes.

Start a Measurement

Sirius L is fully computer operated. The luminometer has to be
connected to a PC via serial or USB cable. Refer to the chapter 4
for installation and set up of the software. Select a protocol type,
set the parameters and run the protocol for measurement.

To start a measurement, open the sample drawer and insert the
first tube into the sample holder. Close the measurement
chamber. The measurement will start immediately after "door
close” and continue until the measurement is finished. Open the
door to change the sample tube and close it again to start the
next measurement.

Instrument Background Measurement

It is recommended to perform instrument background
measurements without tube daily, after the instrument has
warmed up for 30 minutes, to make sure, that the instrument
works well.

Please refer, too, to information about Quality Control in chapter
1.6 and PC software in chapter 4.
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3. Measurement Sirius L Tube Luminometer

Instrument Background Measurement:

0 Use the PC software and select a Single Assay protocol with
the following parameters:

Delay time: 1s

Measurement time: 10s

Start measurement by: Door close
Number of Replicates: 10
Number of Samples: 1

First sample is background: No
Injectors: not active

O Perform the measurements without tubes.

U0 The instrument background meets the specifications if the
following values are obtained:

Background average: #100 RLU/s
A single background value: #130 RLU/s

O In cases of fail repeat the measurement and refer to the
troubleshooting list.

3.4 Measurement with Injectors
34.1 Reflectors
‘> The standard sample holder and the microfuge tube sample

holder are suitable for use with injectors. The standard sample
holder can accommodate 12mm tubes with a length of 75 and 55
mm. For the 55mm tubes, the Plexiglas insert (included with the
shipment) has to be inserted from below. The microfuge tube
sample holder accommodates 1.5ml and 2ml microfuge tubes
with caps.
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Sirius L Tube Luminometer 3. Measurement

3.4.2

Sample Presence Detector

The Sirius luminometer contains a sample presence detector to
prevent injection into an empty sample holder. In cases of a
missing sample tube, a protocol with injection cannot be operated
and the user is informed by the software to insert a sample tube
for operation. The sample detection is only active in cases of
activated injectors.

Start up of Injectors

Q

Depending on the order, the configuration will consist of 0, 1
or 2 injector pumps installed in the instrument. Pumps are
labeled with numbers to simplify the identification. This
number is also used by the PC software to identify the
injectors and to avoid confusion. Refer to figure 2-4 in chapter
2, too.

Place the reagent bottles into the reagent holders.

Connect the reagent bottles to the white tubing of the
respective injector pump. Check afterwards that reagent
bottles have been connected to the appropriate pump and
have not been mixed up.

Assay components may cause a biohazard or risk of infection.
Always handle the injection lines carefully and refer to the kit
inserts and the safety instructions and precautions prior to
work.

All operations and measurements are controlled by the
software.

For priming of injectors please refer to chapter 4.4 for detailed
instructions.

All parts of the injector system coming in contact with
reagents are chemically inert and can be used for a longer
period of time. They have to be cleaned periodically according
to the description in chapter 11.2. The injector lines and tips
should be replaced once a year.

TITERTEK
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3.4.4

62303).docx
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Removing the Injector Head
Do not unscrew and remove the injector head!

The injector head should only be removed in cases of downgrade
of the injectors. Contact Berthold Detection Systems for further
instructions. For replacement of the injector tips, located in the
injector head, refer additionally to chapter 11.8.

In cases of continued work with a mounted blind screw instead of
injector head (downgrade of an injector instrument): Please do not
touch the blind screw during measurement. A strong electrostatic
discharge could cause light within the measurement chamber.

User’s Manual Sirius L-e-2011-11 (ID TITERTEK
BERTHOLD



Sirius L Tube Luminometer 4. Working with PC Software

4.1

TITERTEK
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Working with PC Software

Sirius L is fully computer operated. Depending on the Software
version controlling the luminometer, it acts in two different
measurement modes.

Advanced mode: Every time Sirius L is switched on, it acts in a
unidirectional basic mode, called FB12 mode, first. If Sirius L is
operated via FB12/ Sirius software V2.0 and higher, the software
switches the Iluminometer from the basic FB12 mode to a
bidirectional advanced mode. All operations including injector
functions and shutter operation are now controlled by the
software. Additionally the protocol types Dual Assay and Single
Kinetic have been revised for the advanced mode, as described
in the respective chapters.

FB12 mode: FB12/ Sirius Software versions V1.5 and lower
operate Sirius L in a unidirectional basic mode, called FB12
mode. Once the Sirius L is switched on, it sends data as photon
counts per second periodically every 200ms via RS232 or USB
interface. The data can be integrated using PC software for any
timeframe multiple of 200ms. The injectors are not controlled and
operated by these software versions. The shutter operation is
controlled by firmware.

PC Software Installation

Important information

Please ensure the software is installed in administrator mode. For
work with the software administrator rights are not necessary.

O Close all Windows applications.

U Insert software CD in the CD drive. The CD navigator will
automatically start the internet browser.

O Select “Software” in the navigator bar, then “FB12/Sirius
Software Installation”.

U Double-click the Setup.exe file to initiate the setup.
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U If the CD navigator does not automatically start, open
Windows Explorer and select CD drive. Double-click
start.htm to start the CD and continue, as described above,
to install the software.

O Follow the instructions of the setup program. When the
program is started, the [Welcome] screen is displayed. Click
<Next>. The [Choose Destination Location] dialog box
appears. Click <Next> to keep the defaulted directory
C:\...\FB12 software. Click <Browse> to choose another
directory. Select the base software and the different protocol
types in the [Select Components] dialog box.

Click <Next>: [Select Program Manager Group].

Click <Next> (display of [Start Installation]).

Click <Next> to start the installation.

Upon completion of the installation process, click <Finish>.

O0000d

The software includes a 30 days trial option for non-
purchased software components.

Installation of additional protocol types

Proceed as described above. Select the protocol types needed in
the [Software Components] dialog box. Then complete the
installation.

Instructions for use of USB connection

USB connection is recommended for operating systems
Windows XP and higher. For Windows 2000 please use serial
connection only!

After installation of the FB12/ Sirius software, connect the
luminometer to PC using the USB.

U The PC will recognize that there is a new device and ask for a
driver. The USB driver is part of the FB12/Sirius software and
stored in the directory C:\....\Berthold Detection
Systems\FB12 Software V2\Driver\SiriusL\ USB. Follow the
installation wizard and insert this path to install the driver.

U Depending on your PC and its operating system, the
installation wizard for the driver software may not occur
automatically. Please refer to the Technical Note for USB
driver installation, coming with the instrument, too.
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Initial Software Start Up

O Double-click on the FB12 software ICON.

Q Click on the <Options> button and press <Find
luminometer>. The PC software searches the COM port
where the luminometer is connected, automatically.

QO In the [Default Data storage directory] box, enter the
directory where the measurement data are to be saved. It is
recommended to use the default storage directory.

Important information for Windows Vista and Win 7 users:

The operating system stores measurement data to the
folder <My documents> automatically, independent from
the entered data storage directory.

U To hear a signal at the end of a measurement, select the item
[Beep when measurement is completed]. For Win 7 this
item is only available, if additional loudspeakers are installed.

O Click <OK> to save the entries. The program changes to the
Protocol Manager.
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Figure 4-1:
[Registration
Form] dialog box

Software Registration

FB12/ Sirius software may be used for 30 days without
registration. A prompt to enter a registration password will appear
each time a protocol is selected or the measurement menu is
opened until registration passwords are entered. User may close
the Registration Form dialog box by clicking <Run Now,
Register Later> and continue working with the software.

The passwords must be entered within 30 days in order to
continue working with the software. The [Registration Form]
dialog box appears again; either enter registration password or
click <Cancel> to close this dialog box.

Passwords may be requested via E-Mail, Fax or Web. Follow the
instructions on the registration form. Press the respective E-mail,
Web or Fax button, insert required information in the predefined
mail, fax form or web registration form and forward to

Berthold Detection Systems.

Registration Form g]
Single Assay For FB12/Sirlus Software

Coppight (c) 2005 Berthold Distecton Systere GmbH, A) Rughts Resered

Thes urvagsered verzion of the Sings Assay wil mn for 30 days after bish nn
Plasze regater befors that sme 10 enabls unkmited use

Diawys bt Tiial Pesod Expnd |

To cblan the password to enabils the software. plaass contact Berthold Datecton Spstems
Press the e-mad. the web of the fax tutton to get the contact formudst and reer ol 1egused
wiomalon

O wist D 7 v beiokd-dy comhegsie /sl pho

E-mal Web Fan

Please aries your regatisdon nformalion here

Nans

Compary:

Pausword

Aeguter How Carcel ’

Passwords may also be requested via the BDS homepage.
Please provide the System ID of the PC. The number is printed in
red in the registration dialog of the software.
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Registration

Owner will receive registration passwords from Berthold
Detection Systems (one password for each purchased protocol).

When [Registration Form] dialog box appears, enter the user's
name, the company name and the password for that protocol.
Click <Register Now>. Upon entry of correct passwords, the
software may continue to be used. The [Registration Form]
dialog box will not appear again.

Important information for Windows Vista and Win 7 user:

Due to limited writing authorizations the registration may occur
temporary delayed. It is rarely possible that the registration of a
single protocol has to be repeated.
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Sirius L Tube Luminometer

4.3

Figure 4-2:
Structure of Sirius
PC program
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Protocol Manager

[Protocol types]
Shows the protocol types which can be used as templates for
creating protocols.

[Runable protocols]
Shows a list of created protocols. Protocols are edited using the
buttons in this box:

<Run>
Shows the measurement menu and you can start a
measurement with the selected protocol.

<Edit>
Edit the parameters in the selected protocol.

<Delete>
Delete the selected protocol.

Quick Measurement
is not a protocol type, but a measurement protocol; parameters
may be changed, but may not be stored in separate protocols.

<Retrieve>
Shows the stored measurement data; double-click to open the
desired data file (*.MDS).

<Priming Injectors>
Opens the Priming dialog. Injectors have to be primed prior to
use.

<Options>
Gives information about the used COM port, the Baud rate and
the default data storage directory.

<About>
Gives information about software version number.

<Close>
Closes the protocol manager.
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4.3.2
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Measurement Menu

Select the desired protocol and click <Run>. The measurement
menu is displayed.

Measurement start
By opening / closing the sample drawer or pressing the green
button or the spacebar.

Meas. completed
As soon as the measurement time is over.

Measurement stop
By opening the sample drawer or pressing the red button.

Result fields

To change the size of a result field, move cursor to the right-hand
margin of the header. As soon as the cursor shape changes to a
double-arrow, click the left mouse button and drag the cursor, with
the mouse button held down, left or right.

EXCEL Transfer

Click the button depicted to the left to manually import data into a
new Excel worksheet. The transfer may also be automated in the
protocol.
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4.3.3

Button

Tool

Working with the Software

Meaning

Save measurement data
Import measurement data
into Excel

Print

Start measurement

Stop measurement
Delete last measurement
Display results in
spreadsheet

Display results in a graph
Tile window horizontally
Tile window vertically
Create new data file in

measurement menu

Copy selected data to
clipboard

4. Working with PC Software

buttons on the measurement menu simplify program
handling. Apart from a few exceptions you need not select any
pull-down menus.

Tool buttons and their meaning:

Pull-down menu -> Option

[File] -> [Save (as)]

[Edit] ->[Send to Excel]

[File] -> [Print]

[Measure] -> [Start Measurement]

[Measure] -> [Stop Measurement]

[Measure] -> [Delete Last

Measurement]

[Measure] -> [Kinetics]

[Measure] -> [Kinetics]

[Window] -> [Tile Horizontal]

[Window] -> [Tile Vertical]

TITERTEK
BERTHOLD

User’s Manual Sirius L-e-2011-11 (ID
62303).docx



4. Working with PC Software Sirius L Tube Luminometer

4.4
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Priming Injectors

Injector tubing has to be washed with 5ml of distilled water prior to
first use. Wash also before starting a measurement and when
changing reagents. Proceed as described below.

For measurement injections, the tubing has to be primed first to
ensure that the full volume is injected with the first shot.

To wash or prime the tubing, insert an empty sample tube into the
sample holder!

The dead volume of the tubing is lower than 700pl.

Please note:

Depending on the sample holder and the sample tubes selected,
the total volume for priming is limited. Prime the injectors
consecutively and check the total priming volume to be lower than
the capacity of your sample tubes to avoid overflow. Prime every
injector separately into a new and empty tube.

Proceed as follows to wash and prime the tubing:

QO Connect the reagent bottles to the white tubing of the
respective injector pump. The numbers of the injectors used
in the software are in accordance with the numbers on the
pumps.

O Check afterwards that reagent bottles have been connected
to the appropriate pump and have not been mixed up.

U Select <priming injectors> in the protocol manager. The
priming dialog will open.
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Figure 4-3:
Priming dialog

Priming injectors @

Diirection Yolume [pl] Strokes Taotal Wolume [pl)

Voriector 1 foTue w0 x [ 7 700
I inector 2| = | =[5 |

4. Working with PC Software

| Prime || | Cloge

Mark the check box to enable the respective injector and the
list boxes [Direction], [Volume [pl]], and [Strokes].

Set the injection [Direction]. Select between [to Tube] and
[to Bottle]. It is recommended to select [to Tube].

Set the [Volume] of a single stroke.

Select the number of [Strokes] to define the total injection
volume:

[Volume] x [Strokes] = [Total volume]

To avoid leavings of air, reagents or water in the injector
system, the [Total Volume] should not be lower than 750pl. It
is recommended to operate a second priming cycle with a
new empty tube for every injector, to make sure that residua
have been eliminated.

Recommended maximum total volume (ul) for priming of
a single injector:

75x12mm tubes : <3000ul
55x12mm tubes: <2000ul
Microfuge tubes 2ml: <1000pl
Microfuge tubes 1,5ml: <750ul

Click on <Prime>. Then the selected injectors are initialized
and the lines are washed/primed. The injectors are now
available for measurement.

Click on<Close> to return to the protocol manager.

TITERTEK
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4.5 Total Reaction Volume

Sirius L enables the user to inject into different sample formats.
Before preparing a measurement protocol, please check that the
total reaction volume is within the volume range of the selected
tube. Especially when microfuge tubes are used, the sample and
injection volume have to be reduced to avoid overflow and
splashes outside the tube.

Recommended maximum total reaction volume:

75x12mm tubes : <3000pl
55x12mm tubes: <2000pl
Microfuge tubes 2ml: <1000yl
Microfuge tubes 1,5ml: <750pl

For all protocol types:

Please set the parameter [volume] of the injectors in your
protocol in accordance to this recommendation. If necessary
adapt your assay accordingly.
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4. Working with PC Software

4.6 Comparison of Software Protocols
To help you get a quick overview of the different protocol types,
we have summarized their functions in the table below:
Quick Single Single Multiple Dual Cut-Off-
Measur. |Assay Kinetics Kinetics Assay Assay
Function Measurement | Continuous Several Measurement | Classification
of several measurement | samples, of sample of samples
samples with | of one sample | discontinuous series A and B
replicates measurement
1°' sample = no yes no no yes Yes
BG BG may be BG may be
defined defined
Replicates no flexible yes yes same number |yes: for
for Aand B samples,
neg. and pos.
controls
Number of any flexible 1 sample any, with any same number | yes: for
samples measured with | data points for Aand B samples,
any data points neg. and pos.
controls
Calculations none >1 replicate: >1 replicate: >1 replicate: >1 replicate: >1 replicate:
average value | average value |average value average value |average value
%stdv/av %stdv/av %stdv/av %stdv/av %stdv/av
repl. 1, repl. 2 repl. 1, repl. 2
log/normal log/normal
scaling, scaling,
smoothing, smoothing,
peak half-life peak half-life
time during time during
increase and increase and
decay decay
Kinetics graph | none Not displayed | complete graph | complete graph | Not displayed | Not displayed
in advanced of all replicates | of all replicates | in advanced in advanced
mode mode mode
Miscellaneous | Meas. predefined measurement predefined predefined
sequence | sample start only at sample names | sample names
names closing of different different cut-off
sample drawer | cajculation calculations
formulas for A | and
and B classifications
BG = Background
User’s Manual Sirius L-e-2011-11 (ID
TITERTEK (

62303).docx

BERTHOLD




5. Quick Measurement

5.1

5.2

Sirius L Tube Luminometer

Quick Measurement

This protocol type measures the raw data of consecutively
numbered samples.

Protocol

Q

In the Protocol Manager, select the [Quick Measurement]
protocol and click <Edit>. The [Quick Measurement
Parameters] dialog box appears.

Set Delay time for the measurement and Measurement time
by clicking on the respective arrow buttons.

Select Injectors by marking the respective check box and set
injector Volume and Delay time.

Click <Save> to save the measurement parameters. The
program returns to the Protocol Manager.

Measurements

Q

In the Protocol Manager, select the [Quick Measurement]
protocol and click <Run>. The measurement menu appears
showing the parameters defined for injection and
measurement.

Open sample drawer and insert sample tube.

Close sample drawer. The measurement process starts as
soon as the preset delay time is over.

The result is displayed at the end of the measurement.

Proceed in the same manner to measure the next sample.

62303).docx
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6. Single Assay

This protocol type allows you to run background measurements
and to measure replicates of samples.

6.1 Protocol

Select Single Assay and push <Create>.

Figure 6-1: . .
Digl og box r . Single Assay Parameters - Single Assay
[Single Assay M eazure and delay times
Parameters] . b f lime:
Page 1 Delay tirme: easurement ime:

1.0z il 3.0z :I Save bs..

Start meazurement by
Cancel
" Start button or space bar i+ Door close
ar enter key

Mumber of replicates and zamples

Mumber of replicates: Mumber of zamples:
2 :l 1 :l
[v First zample iz background
Injectors
#1 olurne [ul] Delay [=] #2  Wolume [ul] Delay [£]
N TR I - T N F: -
Comments:
Advanced Ophions... Excel [Th] Options. ..
[Delay time]

Delay before measurement; can be set only if a measurement is
started by closing the sample drawer.

[Measurement time]
Measurement time for each sample measurement.

User’s Manual Sirius L-e-2011-11 (ID
TITERTER 62303).docx
BERTHOLD




6. Single Assay

Sirius L Tube Luminometer

[Start Meas. by]
Select how to start the measurement on the measurement menu:

[Start button]
By clicking the Start button or pressing the spacebar. No
delay time can be defined here!

[Door close]
By closing the sample drawer of the luminometer.

[Number of replicates]
[Number of samples]

[First sample is background] Measurements of the first sample
replicate are considered background measurements.

[Injectors]
Injectors are only active if the check box is marked. Selection of
the respective injector by marking check box #1 and/or #2.

[Volume]
Volume to be injected by the respective injector.

[Delay]
Delay before injection.

<Advanced Options>
Opens page 2 of the Single Assay Parameters dialog box.

[Grid Options]
You may select a flexible table set-up, so that the number of

replicates and/or samples may be changed during
measurement at the push of a button.

[Measurement orders]
Order of measurement

[Across]

Sample | Repl

Rep2

Measurements are carried out by rows: first, all replicates of

the first sample, then all those of the second sample, etc.

[Down]

ple | Repl

Rep2

Measurements are done by columns, e.g. first the first

replicate of all samples, then the second replicate of all

samples, etc.

62303).docx
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6.2

Preparation

Parameter

Measurement start

Results

Graph
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Measurements

Select a protocol (type Single Assay), click <Run> and the
program will go to the measurement menu.

Display of the run parameters. If you have defined the number of
replicates as variable, you may change this by clicking on the
respective button. A background value can also be set manually if
no background measurement is carried out. The value entered
here is subtracted from the raw data of each sample.

By opening / closing the sample drawer or by clicking on the Start
button.

The measurement values will be displayed in a table depending
on the definition in the protocol with the following columns (one
row for each sample):

[Sample] Sample name.

[Rep...] One column has been reserved for each replicate.
If the number of replicates was defined as
variable in the protocol, you may increase the
number of columns by clicking the appropriate
button (+).

[Average] This column contains the average values,
calculated from the replicate results of that row.

[%6SD/AvQ] Standard deviation in percent, divided by average
value.

[Net] Average value minus background value.

[%6SD/Net] Standard deviation in percent, divided by net
average value.

The measurement data trend of each single measurement with
data points can be displayed in a graph by clicking the graph
button. The data will be transferred to the graph at the end of
every measurement.
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7. Dual Assay

Measurement order:
A BABAZB

L]

Figure 7-1:
Calculation of delay
and measurement
times
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Dual Assay

In the Dual Assay mode two sample series A and B are
measured. The sample series can either be measured in the
order A, B, A, B or A, A, B, B. Each series may start with an
injection. A mathematical ratio may be calculated between both
measurement series.

Typical applications: Dual Luciferase Reporter Gene Assay

Description only valid for Sirius L with FB12/ Sirius software
V2.0 or higher.

If the DUAL MEASUREMENT Protocol is selected, the
measurement sequence is automatically divided into two cycles;
an injection may be performed in each cycle. The delay times for
measurements and injections are calculated starting with the
cycle 1.

Cycle 1 Cycle 2
Inj.1 T -

d Ini.1 ‘
d Meas 1 Meas.time 1

dInj. 2

»y
Meas.time 2
d Meas 2

v
\ 4

A A

Start Cycle 1 Start Cycle 2
(T=0)
Where:
dinj. 1 delay 1% injection starting with cycle 1

d Meas. 1 delay measurement 1 starting with cycle 1
Inj. 1 injection 1

dInj. 2 delay 2" injection starting with cycle 1

d Meas. 2 delay measurement 2 starting with cycle 1
Inj. 2 injection 2
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Measurement order:
AAA;B, BB

@

|

7.1

Figure 7-2:
Dialog box
[Dual Assay
Parameters]

Page 1

For measurement order A,B,A,B,A,B cycle 2 is always started
automatically.

If only one injector is installed (Injector 1), but you would like to
perform injections in cycle 2, set the delay time for Injector 1 so
high that it extends into cycle 2.

The measurement sequence AA/A,...,B,B,B in the protocol DUAL
ASSAY may be considered as two individual runs carried out in
succession. This applies for the injector operation, too. The
respective injector parameters will be carried out in sequence A
and sequence B in succession. The PC software measures and
calculates the results as defined in the PC protocol.

Protocol

Select Dual Assay and press <Create>.

"~ Dual Assay Parameters - Y2_DLR PROMEGA_BG_Subtraction

Series A measurement and delay imes Series B measurement and delay times Save

Drelay time: teazurement time: Drelay time: Meazurement time: Cave fs

30s = [106s = || [0 = [1oes -

i)

Cancel
Start measurement by MNumber of replicates and samples
(" Start button or space bar or enter key Mumber of replicates: Mumber of zamples:
* Door close 3 :I 5 I‘
Measurement options
. . Transform: Measurement order;
v First sample is background
AdB - A B.& B, -
Injectars
#1 Yolume [ul] Delay [2] #2  Yalume [ul] Delay [£]
AT I = v o s =
Commetts:
Advanced Optiong... | Excel [TH] Options...

[Series A measurement and delay time]

[Delay time]
Delay for sequence A prior to each measurement; can be set only
if a measurement is started by closing the sample drawer.

TITERTEK
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[Measurement time] for each sample measurement of series A.

[Series B measurement and delay time]
Enter parameters for series B in the same manner as for series A.

[Start Meas. by]
Select how to start the measurement:

[Start button]
By clicking on the Start button or by pressing the spacebar. No
delay time can be defined here!

[Door close]
By closing the sample drawer.

[Number of replicates and samples]
[Number of replicates]
[Number of samples]

[First sample is background]
Measurements of the first sample replicate are considered
background measurements.

[Measurement options]

[Transform]
Select the calculation formula.

[Measurement order]

Selection of order: Either one sample of sequence B after each
one of sequence A, or all samples of sequence A in a row and
then all those of sequence B.

[Injectors]
Injectors are only active if the check box is marked. Selection of
the respective injector by marking check box #1 and/or #2.

[Volume]
Volume to be injected by the respective injector.

[Delay]
Delay before injection.
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Preparation
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Measurement start
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Measurements

Select a protocol (type Dual Assay), click <Run> and the
program will go to the measurement menu.

Display of protocol parameters. The measured background values
are displayed in the [Background A] and [Background B] text
boxes, if the first sample of each sequence was defined as
background in the protocol. A background value can be entered
manually. The value displayed here will be subtracted from the
raw data of each sample.

By opening / closing the sample drawer or by clicking the Start
button.

Display of measured values:
[Sample] Sample name.

[Net A] Net rate of series A = average value of the
replicates of the first sample of sequence A,
minus background.

[Net B] Net rate of series B

[A ...B] Calculation of the two net rates according to the
formula defined in the protocol

[%SD/Avg] Standard deviation in percent/average value.
[Rep ...A] Measurement value for replicates of series A.

[Average A] Average value from replicate results of series A of
the respective row.

[%SD/Avg] Standard deviation in percent/average value.
[Net] Average value minus background (series A).
[%SD/Net] Standard deviation in percent/average value.

The following columns contain the measured values for series B.
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8.1

Figure 8-1:
Dialog box
[Dual Assay
Parameters]

Page 1

Single Kinetics

The measurement type Single Kinetics is used to measure the
trend of the light emission over a specific period of time.

Description only valid for Sirius L with FB12/ Sirius software

V2.0 or higher.

Protocol

Select Single Kinetics and push <Create>.

Sk Single Kinetics Parameters - Single Kinetics

Mote: Sampling time = Total duration / Mo, of data points
[Tmz...99mz or multiples of 100ms up to 10 min)

Sftf ltEfit:: rI:tij’tltc-n aor space bar ar enter key Nlio' o [eplicatBS:.
* Door close 1 Z‘
Injectors
#1 Wolume [ul] Delay [5] #2 Volume [ul] Delay [5]
e [ oo T = =

Comment:

Time settings
Drelay time: Total duration: Sampling time:
| 10s = | 10.000s = | 0.100s < Cave As
Mo. of data points:
100 Cancel

Advanced Options... Excel [Th] Dptiohs. ..

[Time settings]

The following 4 parameters of this group box are mutually

conditional (with the exception of delay time):

[Delay time]
Delay before each measurement;

can be set only if

a

measurement is started by closing the sample drawer.

[Total duration]

Total sample measurement time, including the following times:
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[Sampling time]
Measurement time per data point.

[No. of Data points]
Number of data points multiplied by the sampling time shows the
total duration of the measurement.

Select the [Total duration] first and the [Sampling time]
afterwards. The [No. of Data points] is the result of these two
settings and will be calculated automatically.

For [Sampling time] lower than 0,1s the [No. of Data points] is
limited to 250 points.

[Start Meas. by]
Select how measurement is to be started on the measurement
menu.

[Start button]
By clicking the Start button or pressing the spacebar. No delay
time can be defined here!

[Door close]
By closing the sample drawer. Measurements with injectors can
only be started in this manner.

[Number of replicates]

[Injectors]
Injectors are only active if the check box is marked. Selection of
the respective injector by marking check box #1 and/or #2.

[Volume]
Volume to be injected by the respective injector.

[Delay]
Delay before injection.

<Advanced Options>
Click this button to open page 2 of the Single Kinetics
Parameters dialog box.

[Use luminometer as time basis]
Select the luminometer as time basis.
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Measurements

Select a protocol (type Single Kinetics), click <Run> and the
program will go to the measurement menu.

Display of protocol parameters. You may type a background value
into the [Background RLU/s] box. The value entered here is
subtracted from the raw data of each sample.

By opening/closing the sample drawer or by clicking the Start button.

For protocols with a sampling time < 0,1s: All measured data
of a replicate will be transferred to the result table at once at the
end of the measurement.

For protocols with a sampling time 20,1s: The measured value
for every sampling time interval will be transferred immediately
after measurement.

The measurement values will be displayed in a table depending
on the definition in the protocol with the following columns (one
row for each sample):

[Time] Length of time the light emission is measured.

[Rep...] Measurement values for individual replicates.

[Average] Average value of replicates.

[YostdV/Av] Standard deviation in percent, divided by average
value.

[Net] Net value (average value minus BG value)

[%SD/Net] Standard deviation in percent, divided by net
average value.

The measurement data trend of each single measurement can be
displayed in a graph, either online or at the end of the
measurement, by clicking the graph button. Further options for
processing the graph become visible when you enlarge the graph
window.

[Group] Select which replicate curve(s) is to be displayed.
[Smoothing] Smoothes all displayed curves.
[Log scale] Logarithmic scaling.

[RLU-range] Select if scaling is to be applied automatically or
manually.
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9. Multiple Kinetics

In the Multiple Kinetics mode, the trend of several samples is
measured in parallel over a longer period of time.

9.1 Protocol

Select Multiple Kinetics and push <Create>.

Fl_g ure 9-1: Multiple Kinetics Parameters - Multiple Kinetics

Dlalo_g bOX i A Time gettings

[MUItI ple KI netics Delap time: Total durahion: Sampling time:

Parameters] 108 = [imoos = [ies = Save &s..
Mo. of data paints: Interval tine:

Page 1 e o fow G |

Mote: Interval ime = Tatal duration / Mo, of data pointz [to nearest 0.2z]

Replicates and samples

MHumber of replicates: Mumber of samples:
4 R
Injectors
#1 Yolume [ul] Drelay [2] #2 1 Delay [z]
¥ o o = r = =
Comments
Excel [Th] Optionz...

[Time settings]
The following 5 parameters of this group box are mutually
conditional (with the exception of delay time):

[Delay time]
Delay before every measurement.

[Total duration]
Total sample measurement time, including the following times:

[Sampling time]
Measurement time per data point.
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[No. of Data points]
Number of data points multiplied by the interval time shows the
total duration of the measurement.

[Interval time]
The interval time may be longer than the respective measurement
time of the data point.

[Number of replicates / samples]
The number of replicates or samples.

[Injectors]

Injectors are only active if the check box is marked. Selection of
the respective injector by marking check box #1 and/or #2.
Injections can only take place once in the first measurement cycle
of a tube according to the injection delay time adjusted. They are
not repeated in every measurement interval.

[Volume]
Volume to be injected by the respective injector.

[Delay]
Delay before injection.

A measurement can only be started by closing the sample
drawer !

Measurements

Select a protocol (type Multiple Kinetics), click <Run> and the
program will go to the measurement menu.

Display of protocol parameters. You may type a background value
into the [Background RLU/s] box. The value entered here is
subtracted from the raw data of each sample.

By opening/closing the sample drawer.
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Graph

9. Multiple Kinetics

Measured values are displayed in a table:

[Time]

[S1 Repl]

[S1 Rep2]

[Average]
[%SD/Avg]

[Net]
[%SD/Net]

[S2 Repl]

[S2 Rep2]

[Average]

[%SD/avg]

[Net]
[%SD/Net]

[S...Rep...]

Length of time, over which the light emission is
measured. The number of data points in [time] is
calculated by dividing the total measurement
duration by the interval time.

Measurement value of the first replicate of the first
sample.

Measurement value of the second replicate of the first
sample.

Average value of replicates of the first sample.

Standard deviation in percent, divided by average
value.

Net value (average value minus BG value).

Standard deviation in percent, divided by net
average value.

Measurement value of the first replicate of the second
sample.

Measurement value of the second replicate of the
second sample.

Average value of replicates of the second sample.

Standard deviation in percent, divided by average
value.

Net value (average value minus BG value).

Standard deviation in percent, divided by net
average value.

Further samples with replicates.

The measurement data trend of each single measurement can be
displayed in a graph, either online or at the end of the
measurement, by clicking the graph button. Further options for
processing the graph become visible when you enlarge the graph

window.
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10. Cut-off Assay

A Cut-off protocol classifies samples into three categories. So-
called cut-off thresholds (high and low) are measured by defining
fixed parameters and measuring negative and positive controls.

10.1 Protocol

Select Cut-off ASSAY and press <Create>.

Fi_gure 10-1: % a Cut-off Assay Parameters - Cut-off Assay
Dialog box .
[Cut-off Measure and delay times
Param eters] Dielay time: Meazurement hime;
1 0s il |3.Els il Save Az
Page 1
Start meazurement by Cancel
" Start button or space + [Door close
bar or enter key
Analytes Megative/Pozitive controls
Feplicates: Samples: Meqgative replicates: Pozitive replicates:

I I I~ | = i

v First zample 1z background

Cut-off calculations

Offzet Meq. Factar Poz. Factar
Low cut-off = |0 + 1,00 * [Meg Met] + 0,00 * [Paz. Net]
Offzet Meq. Factor Poz. Factar
High cut-off = |0 + |0.00 * [Meg Met] + [1.00 * [Pos. Net]
|njectors
#1  Wolume [ul] Delay [=] #2 “olume [ul] Delay [=]
oo = i -+ TR F. -]
Comments:
Advanced Ophions... Excel [TH] Dptions...
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[Delay time]
Delay time before measurement; can be set only if measurement
is started by closing the sample drawer.

[Measur. time]
Measurement time for each sample measurement.

[Start Meas. by]
Select how to start the measurement on the measurement menu:

[Start button]
By clicking the Start button or pressing the spacebar. No
delay time can be defined here!

[Door close]
By closing the sample drawer of the luminometer.

[Analytes] Define the number of replicates and samples.

[Negative/Positive controls]
Define the number of replicates of negative and positive controls.

[First sample is background]
Measurements of the first sample replicates are treated as
background measurements.

[Cut-off calculations]
Definition of low and high threshold by the following parameters:

[Offset] Offset (RLU) value

+  [Neg. Factor] any constant

X [Neg. Net] net rate of negative control
+ [Pos. Factor] any constant

X [Pos. Net] net rate of positive control

[Injectors]
Injectors are only active if the check box is marked. Selection of
the respective injector by marking check box #1 and/or #2.
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[Volume]
Volume to be injected by the respective injector.

[Delay]
Delay before injection.

<Advanced Options>
Click this button to open page 2 of the Cut-off Parameters dialog
box.

[Result text]
Designation for Cut-off results. The following designations are
defaulted:

[Negative result text] NEG
[Positive result text] POS

[Equivocal result text]  +/-

Measurements

Select a protocol (type Cut-off), click <Run> and the program will
go to the measurement menu.

Display of protocol parameters. You may type a background value
into the [Background RLU/s] box. The value entered here is
subtracted from the raw data of each sample.

By opening/closing the sample drawer or by clicking the Start button.

Measured values are displayed in a table:

[Sample] Sample name.

[Rep...] A column is reserved for each replicate.

[Result] Result column. POS, NEG or +/- as result.
[Average] Average value from the replicates of one sample.
[%6SD/Avg] Standard deviation in percent/average value
[Net] Average value minus background value.
[%SD/Net] Standard deviation in percent/net average value.
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11.1
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Maintenance

The SIRIUS L Tube Luminometer hardly requires any
maintenance. It should, however, be protected from dirt and
cleaned occasionally. Use only the described instructions for
cleaning and decontamination.

Surfaces of Sirius L:

Housing: Aluminium, varnished
Door: PUR-Baydur 110F, varnished
Sample holder: Aluminium, outside black eloxadized

The surfaces of Sirius L are tested to be resistant against the
chemical solutions for cleaning and decontamination.

Components of the Injector system:

Tubing: PTFE (Teflon)
Fittings: PTFE (Teflon)
Nuts, T-Piece: Kel-F

Pumps: PTFE, Kel-F, glass

The injector system is composed of well-proven and chemically
inert material, resistant against the solutions for cleaning and
decontamination of the injector system.

Maintenance of Surfaces

Cleaning of surfaces

The instrument surface is protected by a robust and washable
varnish that can be cleaned using a damp cloth. If necessary, use
a mild detergent. The sample drawer, the sample holder and
especially the measurement window also have to be kept clean
and should be wiped off with a damp cloth. If necessary, use a
mild detergent or 70% Isopropanol. A periodic weekly cleaning is
recommended. Additionally, the measurement chamber and
sample holder have to be cleaned in cases of unexpected high
measurement values.
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Decontamination of surfaces

In cases of biohazard spillage, other kinds of pollution or
reshipment for service, decontamination is necessary. The outer
surface, the measurement chamber and the sample holder may
be decontaminated with 70% Ethanol or 70% Isopropanol or 0,5%
Na-Hypochlorite solution (containing 5% free Chlorine). Always
wear gloves while handling with chemical solutions. Follow also
the instructions and recommendations included in the package
insert for the test to be conducted. After use of Na-Hypochlorite
solution, wipe off the respective surfaces with distilled water and
dry them afterwards to avoid corrosion.

No fluid should ever enter the instrument! If this happens,
disconnect the device from mains and call for service!

Before Service or shipping any instrument back to Berthold
Detection Systems, the instrument has to be decontaminated.
Refer to the Decontamination Form in this manual for details.

11.2 Maintenance of the Injector System

All materials coming in contact with reagents are chemically inert
and can be used repeatedly for a longer period of time. Anyway,
regular maintenance is necessary.

Rinsing the injector system (see section 11.4).

Daily Rinse with deionized or distilled water
Before and after |Rinse using acid/base cleaning procedure. See chapter 11.5.2.
longer breaks

Regular Maintenance and Checks

Injector pump ¢ Rinse after use.

e If the pump has not been in use for a longer period of time,
you should clean it with water.

¢ Do not operate it without liquid.

e Check for leaks. If you detect any leaks, call service.

Injector tubing e Do not bend the reagent lines!

e Check tubing and screw fittings for leaks. If you detect any
leaks, replace the injector tubing (see enclosed spare part Kit).
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Injector tips e Replace injector tips regularly.

Injector unit e If liquid gets inside the instruments, turn the instrument off,
open the injector unit and clean the dirty parts. Try to identify
the cause of the leak (leaky screw fitting or faulty pumps) and
take the appropriate measures (tighten fitting screw or replace
injector unit together with the tubing).

Decontamination of injector system

In cases of ¢ Rinse the injector system with distilled water first.
potential ¢ Decontaminate the injector system according to description in
biohazard chapter 11.6.

contamination
Storage/Return e Decontaminate the luminometer.

shipment e See and fill out the Decontamination form.

11.3 Maintenance Frequency Schedule
Daily/ Weekly/ Yearly/ Before
before/after As needed As needed Storage/Ship
use ment/As

needed

Tasks for all models

Clean external

surface \

Clean sample

compartment v

Decontaminate

instrument v

surfaces

Additional Tasks for Injector Models

Rinse injector
pump and tubing v
Clean injector head

Exchange injector
tips
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Clean reagent
bottles

Replace injector
tubing

Rinse injector
system with
acid/base

Decontaminate
injector system

11.4

11.5

1151
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Make sure no liquid gets inside the instrument! If this
happens, disconnect the device from mains and call for
service!

Rinsing/Priming Injector Tubing

Rinsing and priming of the injector tubing is controlled by the PC
software. Use the submenu <Priming Injectors>(see chapter
4.3.1).

Rinse the injector tubing system regularly after use with distilled
water.

Cleaning the Injector System

The injector system has to be cleaned regularly to keep it fully
functional and to avoid wrong measurement results due to
reagent leavings or blocked reagent lines. Use the submenu
<Priming Injectors> of the PC software to clean the injector
system.

Daily Cleaning Procedure

Use distilled water to flush reagents out of the injector system. Put
the still filled tubing into the supply bottle containing distilled
water. Open the priming dialog and act according to the
description in chapter 4.4Select the maximum total priming
volume recommended for your sample format.
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11.5.2
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Basic Cleaning Before or After Long Breaks

Acid/Base Cleaning Procedure

To retain the fluids in the pumps for approximately 10 minutes,
open the priming dialog and act according to the description in
chapter 4.4. Select the maximum total priming volume
recommended for your sample format

Place a new sample tube into the instrument for each cycle!
Proceed as follows:

1. Wash with distilled water

O Proceed as described above.

2. First cleaning step

U

Fill the respective injector with 0.1N NaOH.

U

Leave this solution in the system for approximately 10
minutes.

Rinse the injector system with distilled water.
Second cleaning step

Fill the respective injector with 0.1N HCL.

OO0 @ 0O

Leave this solution in the system for approximately 10
minutes.

U

Rinse the injector system with distilled water.

Promega Reagents Cleaning Procedure

One of the Promega Dual Luciferase Assay reagents, the Stop &
Glo™ Reagent, has a slight affinity to plastic materials. To avoid
cross contamination when changing reagents, we recommend
following the cleaning procedure outlined below.

To retain the fluids in the syringes for approximately 30 minutes,
open the priming dialog and act according to the description in
chapter 4.4. Select the maximum total priming volume
recommended for your sample format.
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Place a new sample tube into the instrument for each cycle!
Proceed as follows:

Wash with distilled water

1.
U Proceed as described above.

no

First cleaning step

(M

Fill the respective injector with Ethanol (70%).

O Leave this solution in the system for approximately 30
minutes.

U Rinse injector system with distilled water.

3. Rinseinjector system again with distilled water.

Decontamination of Injector System

If the outer surfaces of the injection system have been
contaminated with potential biohazard material or with other kinds
of pollution, they can be treated according to the description for
decontamination of surfaces in chapter 11.1.

If it is necessary to decontaminate the pumps, tubing and injector
head, proceed in the following way:

O Clean the respective injector system with the Acid/Base
cleaning procedure.

Q Fill the respective injector with 70% Ethanol or Isopropanol.

U Leave this solution in the system for approximately 10
minutes.

U Rinse injector system twice with distilled water.
Place a new sample tube into the instrument for each cycle!

The injector system has to be decontaminated before storage and
shipment and in cases of contamination. It is recommended to
decontaminate the injector system at least once a year.

No fluid should ever enter the instrument! If this happens,
disconnect the device from mains and call for servicel!
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11.7

11.7.1

Figure 11-1:
Tubing connections
at the pump head

Installing Tubing Connections

If a tubing connection (at the pump head or injector head) is
faulty, or if you want to replace an injector tubing, you have to
provide a new tubing connection. An Injection Tubing Set is
supplied with the instrument. Please refer to the enclosed
description.

Connections at the Injector Pumps

Q

Q

Drain pump: insert sample tube and run a wash cycle with
several shots without having a bottle of liquid connected.

Turn Sirius L off and disconnect the power cable from mains.

Unscrew the old tubing's fitting screw at the pump head and
put tubing aside.

The Injection Tubing Set provides converted injection tubing
for the injection line (black) and for the sucking line (white).
For black and white tubing: The tubing end with the white
fitting screw must be used for connection to the pump head.

Insert new tubing with T-piece into the threaded bore hole of
the pump head, turn the white fitting crew with its washer into
the threading of the pump head and finger-tighten it. Do not
use any tools.

Black tubing from
pump to injector
head

P

White
tubing
from bottle
to pump
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Figure 11-2: T-piece  Washer White fitting screw
Assembly of the
white and black \
tubing connections —1  White or black
at the pump Pump <+—— H: @:L ,,,,,,,,,, | tubing
® The pump thread is made of soft Teflon material. Make sure
1 the screw does not get jammed in the screw thread.
11.7.2 Connection at Injector Head
- Please take extreme care when replacing screw fittings at the
‘ ll injector head, as the measurement chamber opens directly
above the detector. Although the sensitive detector system is

protected against incident light by a shutter, which is automatically
closed when the luminometer is switched off, do not leave the
instrument open for a longer time. Always work as quickly as
possible when removing the tubing connections.

Please follow the installation steps described below to rule
out damage to the detector!

O Drain injector system: insert sample tube and run a wash
cycle with several shots without having a bottle of liquid
connected.

O Turn Sirius L off and disconnect the power cable from mains.

U Unscrew tubing connections from the pump.

U To open the connection at the injector head push back the
protective rubber of the tubing, untie the black fitting screw at
the injector head and put black tubing aside. For exchange
of a tubing connection replace only the tubing with the
black fitting screw. If servicing the injector tip is not
required, do not untie or replace the Banjo nut of the
injector tip assembly.
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Figure 11-3:
Connections at the Injector tubing Black fitting
injector head screw  with
_____— protective
rubber

Banjo nut

Injector head

Figure 11-4:

Assembly of the T-piece Washer Black fitting screw  Protective rubber
black tubing

connection at the D b

|nject0rb][|p Injector Black tubing
assembly head

O The Injection Tubing Set provides converted black injection
tubing for the injection line. Insert the black fitting crew at the
tubing's end with its T-piece into the Banjo nut of the
respective injector tip assembly. Turn fitting screw into the
threading and finger-tighten it. Don’t use any tools!

O Then reconnect the tubing to the pumps again. Refer to
chapter 11.7.1 for details.
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Exchange Injector Tips

Please take extreme care when replacing screw fittings at the
injector head, as the measurement chamber opens directly
above the detector. Although the sensitive detector system is
protected against incident light by a shutter, which is automatically
closed when the luminometer is switched off, do not leave the
instrument open for a longer time. Always work as quick as
possible when removing the injector tips or parts of the injector tip
assembly.

Please follow the installation steps described below to rule
out damage to the detector!

O Drain injector system: insert sample tube and run a wash
cycle with several shots without having a bottle of liquid
connected.

O Turn Sirius L off and disconnect the power cable!

U Unscrew tubing connections from the pump.

Configuration of the Injector Tip Assembly
The injector tip assembly consists of three parts:
O Injector tip, located inside the injector head
U black Banjo nut

O Teflon insert, located inside the Banjo nut

The Teflon insert must be pushed into the Banjo nut up to the
tapering point. It seals the tubing system towards the tip. The
injector tip is located inside the injector head. These parts are
fitted into each other, when the Banjo nut with Teflon insert is
screwed into the injection head with injector tip inside.
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Figure 11-5:
Configuration of the
injector tip
assembly

11.8.2
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v

;
V

Teflon insert W
U

Banjo nut

Injector tip

Replacing Injector Tips
The injector tips are located inside the injector head.
O Push the protective rubber up at its thicker end.

U Unscrew the black Banjo nut with the Teflon insert from the
injector head. Do not unscrew the injector head!

O Use the widening tool to unscrew and remove the old injector
tip, located inside the injector head..

O Insert a new injector tip into the injector head.

O Screw Banjo nut with Teflon insert into the injector head
(finger-tight — do not use any tools!).

O Screw the black fitting screw of the black tubing into the Banjo
nut and cover it with the protective rubber.
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11.8.3 Replacing the Pump Syringe

Faulty (e.g. leaky) pump syringe must be replaced.

Figure 11-6:
Design of a Cavro
pump ) ~ —Pump head

Syringe with knurled screw

Piston

Syringe piston holder

O Drain pump by running a wash cycle with several strokes
without liquid.

O Turn Sirius L off and disconnect power cable.

U Open knurled screw at the syringe. Detach it from the pump
head, and push it down with the syringe piston holder.

O Take the syringe from the front out of the syringe piston
holder.

U Insert new syringe in the syringe piston holder, push it up and
fix it with the knurled screw to the pump head.

U Reconnect power and turn instrument back on.
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Troubleshooting

12. Troubleshooting

In cases of malfunction or not expected measurement values

refer to the troubleshooting

distributor or Berthold Detection Systems.

list and/or contact your local

Detected fail

Possible reason

Reaction

Background value
>100 RLU/s

Pollution of sample
holder and
measurement
chamber with
luminescent material

Clean sample holder
and measurement
chamber. Refer to
chapter 3.3 and 11.

Pollution with
luminescent material
inside the instrument

Service required;
contact BDS

Blind screw, injector
head or fitting screw
of injector tubing on

top of the instrument
not tightened

Check blind screw or
all connections to be
tightened; refer to
chapter 2 for details

Instrument has been
setupina
suboptimal
environment

Check installation
procedure for
compliance with
operating conditions

In cases of a blind
screw on top of a
non injector
instrument: blind
screw has been
touched during
measurement

Repeat
measurement
without touch;
contact BDS in
cases of further fail

TITERTEK
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Operation conditions
outside specified
range

Operate instrument
only within the
specified humidity
and temperature
range; refer to the
Technical data

Sample tubes
exposed to bright
light or handled
immoderate

Protect tubes from
bright light and
minimize handling

Background or
measurement value
to low (0 RLU/s)

Detector or
electronics damaged

Service required,;
contact BDS

Instrument switched
off or not connected
to mains

Check connection to
mains and switch on
the instrument

Unexpected or
wrong
measurement value

Sample holder not
readily fixed->
Sample position
suboptimal

Check the screws of
the sample holder to
be tightened: chapter
2.

Injectors are not
primed correctly

Refer to chapter 4.4.

Injector lines
contaminated or
blocked

Clean the injector
system . Refer to
chapter 11.

Wrong
measurement
protocol used

Check the protocol
settings.

Measurement value
to high

Pollution of sample
holder and
measurement
chamber with
luminescent material

Clean sample holder
and measurement
chamber. Refer to
chapter 11.
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Pollution with Service required,;
luminescent material | contact BDS
inside the instrument

Pollution of the Clean and
injector system with | decontaminate
luminescent material | injector system.

or other kinds of Refer to chapter
troublesome 11.5.
solutions

Injector head, fitting |Check all

screw of injector connections to be
tubing or blind screw |tightened; refer to
on top of the chapter 2 for details.

instrument not
tightened or

Do not service an
instrument when it is

removed connected to mains
and switched on!
Unexpected Too much light Dilute the sample
Overload signal of
30e6 RLU/s
Shutter fall Service required,;
contact BDS
Sample does not Wrong sample Refer to chapter 2
really fit the sample |format for the and select a sample
holder (too big, too |desired sample format specified for
small, jiggling) holder your sample holder

Injector not primed | Injector not enabled |Enable the
respective injector in
the priming dialog

Lines and pumps Lines are not Connect the lines to
empty after priming |connected to the the reagent supply
respective reagent |bottles
supply bottle
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Lines not totally
filled after priming

Total volume smaller
than the dead
volume of tubing

Prime again or select
a higher total volume

Overflow during
priming

Total priming volume
too big for the
selected sample
tube

Clean sample holder
and measurement
chamber; select a
smaller total volume
adequate to your
sample tube-> refer
to chapter 4.4

If fluids entered the
instrument,
disconnect the it
from mains and call
the service

Injector does not
work

Injector fall

Service required;
contact BDS

Injector has not
been selected in the
PC protocol

Check your PC
protocol and activate
the respective
injector

Injector works, but
does not inject
reagent

Reagent bottle
connected to the
wrong injector line

Always check the
reagent supply
bottles to be
connected to the
right injector number
and line.

Injector lines are not
dipped into the
reagents

Check the lines to be
dipped into the
reagents

Wrong injector
used

Injectors confounded

Always check the
reagent supply
bottles to be
connected to the
right injector number
and line.
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12. Troubleshooting

Wrong injector
selected at the
measurement
software

Select the right
injector in the
measurement
protocol

Wrong injection
volume

Wrong volume
selected

Adjust injection
volume

Lines blocked

Refer to chapter
Maintenance for
Cleaning procedures

Overflow during
injection

Injection volume to
big

Check the total
reaction volume to
be within the range
for your sample tube;
refer to chapter and
adjust your assay
system

If fluids entered the
instrument,
disconnect it from
mains and call the
service

Injector tips leaking

Old injector tips

Maintain the injector
tip assembly.

Injector tubing
leaking

Screws of the
injector system not
tightened

Finger-tighten
white/black fitting
screw

TITERTEK
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13. Technical Data

13.
13.1

Sirius L Tube Luminometer

Technical Data

Luminometer

Sample format

Tubes up to 12 mm diameter and 75 mm length, microfuge tubes
1.5 ml and 2 ml, 35 mm culture dishes, liquid scintillation vials up
to 20 ml.

Injection operation with tubes 12 mm x 75 or 55 mm and
microfuge tubes 1.5 and 2 ml

Detector Photomultiplier tube with bialkali cathode, effective spectral
range 300-600 nm, operated in photon counting mode

Measurement Retractable drawer with interchangeable reflectors and sample

Chamber adapter

Sensitivity Less than 0,5 zmol firefly luciferase,

1 amol ATP in a HS ATP assay

Dynamic range

6 decades

Interfaces

RS 232 or USB interface for PC connection

Injector

0, 1, 2 (upgrade possible)

Injection volume

20 — 500 pl adjustable in steps of 1 pl

Tubing Chemically inert PTFE tubing and connections (PTFE or KEL-F)
Dimensions W 349 mm, D 150 mm, H 241 mm (without injection tubing)

W 349 mm, D 185 mm, H 367 mm (with injectors and lines)
Weight approx. 3,6 kg (5.4 kg with 2 injectors)
Power supply Desktop power supply and power cord

100-240V AC

24V | 2,5A DC
Temperature Storage 0° - 40° C up to 80% humidity (@30°C), non condensing
range and Operation 10° — 35°C up to 70% humidity
humidity
Transport -25° to +60°C, up to 75% humidity, in original cardboard box and
conditions free of liquids.
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Sirius L Tube Luminometer

13.2

13. Technical Data

PC Software

PC software

. ® L
MS Windows application for control, measurement and
evaluation

Platform/
Required
Hardware

Microsoft Windows compatible PC, Pentium like processor, RS
232 or USB port

Operating System

. ® . ) ® .
Windows 2000, XP, Vista, Windows 7; 32 bit

Additional Microsoft Excel™ 2000 or higher (optional)
Software

Standard Protocol Manager, Quick Measurement
configuration

Additionally

Single Assay, Dual Assay, Single Kinetics, Multiple Kinetics, Cut-

available off Assay
13.3 Accessories
Order number | Description

18100026 Reflector for microfuge tubes
13200500 5 ml tubes, 12x75 mm, 500 each
14000130 Luminescent TestTube for validation of Tube Luminometers

TITERTEK
BERTHOLD

For spare parts please contact your local distributor
or service@titertek-berthold.com
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14. Preparing Sirius L for Transport Sirius L Tube Luminometer

14. Preparing Sirius L for Transport

If it should become necessary that Sirius L has to be serviced
please observe the following instructions for shipping it to your
local distributor or Berthold Detection Systems.

1. Turn luminometer off and disconnect power supply.

2. Clean the instrument according to the instructions for cleaning
and decontamination listed in the decontamination form.

3. For safe shipment put the luminometer and the accessory
box into the original cardboard box and seal it. If the original
box is not available please contact service@titertek-
berthold.com. We will send a box back to you.

4. Before return please contact your local distributor or Berthold
Detection systems for shipping instructions.
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Sirius L Tube Luminometer 15. Decontamination Form

15. Decontamination Form

Any laboratory instrument used for clinical or research analysis maybe considered a biohazard
and requires decontamination prior to handling. Universal precautions are suggested wherever
applicable.

Before shipping any instrument back to Berthold Detection Systems the luminometers have to

be cleaned in the following way:

1. Wash the housing with a moist cloth, if necessary use a mild detergent or 70%
Isopropanol.

2. Use 70% Isopropanol for sterilizing the injection lines after 10 minutes incubation time.
Rinse with distilled water thoroughly.

3. Empty the injection lines.

4. Open the access door, remove and clean the reflector, then clean the measurement
chamber with the measurement window carefully. Decontaminate the instruments
surfaces, measurement chamber and sample holder with 70% Isopropanol according to
the description in the chapter “Maintenance”. Install the reflector again according to the
description.

5. Use cotton tipped applicators for hard to reach areas, if necessary.

Berthold Detection Systems only accepts instruments for repair together with a filled out
decontamination form. Thank you.

Instrument Type:

Serial Number:

[ ] I confirm that the specified instrument was decontaminated according to the above
described decontamination procedure
[ ] 1 confirm that the above specified instrument had no contact to any hazardous material.

Company

Contact Person

Position

Telephone

Date: Signature:

Please copy and fax to:
Berthold Detection Systems, Bleichstr. 56-68, 75173 Pforzheim,
Tel.:+49-(0)7231-9206-0, Fax -50
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